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QUESTION 1

You work as an Office Assistant for Tech Tree Inc. You have created a report in a workbook in Microsoft Excel 2013.
You have a number of PivotTables in a single report. You want to apply the same filter to all of those PivotTables. For
this purpose, you are required to create a slicer in one PivotTable and share it with other PivotTables. Which of the
following steps will you take to accomplish the task? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. In the Insert Slicers dialog box, select the check box of the PivotTable fields for which you want to create a slicer. 

B. Click Insert Slicer in the Sort and Filter group on the Options tab. 

C. Hold down CTRL, and then click the items on which you want to filter. 

D. Select the Macro enabled checkbox of the PivotTable fields for which you want to create a slicer in the Insert Security
dialog box and then click OK. 

E. Click anywhere in the PivotTable report for which you want to create a slicer. 

Correct Answer: ABCE 

 

 

QUESTION 2

You work as an Office Assistant for Media Perfect Inc. You have created a spreadsheet in Excel 2013 and shared it with
the other employees of the company. You select the Encrypt with Password option as a protection measure for the
document you are sharing. Now, you have to specify a password in the Password box in the Encrypt Document dialog
box appeared for editing the document. But you have forgotten the password. What will happen in this situation? 

A. You will use a new password. 

B. You will ask Microsoft to retrieve the password. 

C. You will fetch the password from the list in which you have saved it. 

D. You will create a new document. 

Correct Answer: C 

The various Protect Workbook options are as follows: 

1.

 Mark as Final: This option is used to make the document read-only. When a spreadsheet is marked as final, various
options such as typing, editing commands, and proofing marks are disabled or turned off and the spreadsheet becomes 

read-only. This command helps a user to communicate that he is sharing a completed version of a spreadsheet. This
command also prevents reviewers or readers from making inadvertent modifications to the spreadsheet. 

2.
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 Encrypt with Password: When a user selects the Encrypt with Password option, the Encrypt Document dialog box
appears. In the Password box, it is required to specify a password. Microsoft is not able to retrieve lost or forgotten 

passwords, so it is necessary for a user to keep a list of passwords and corresponding file names in a safe place. 

3.

 Protect Current Sheet: This option is used to select password protection and permit or prohibit other users to select,
format, insert, delete, sort, or edit areas of the spreadsheet. This option 

protects the worksheet and locked cells. 

4.

 Protect Workbook Structure: This option is used to select password protection and select options to prevent users from
changing, moving, and deleting important data. This feature enables a user to protect the structure of the worksheet. 

5.

 Restrict Permission by People: This option works on the basis of Window Rights Management to restrict permissions. A
user is required to use a Windows Live ID or a Microsoft Windows account to restrict permissions. These permissions 

can be applied via a template that is used by the organization in which the user is working. These permissions can also
be added by clicking 

Restrict Access. 

6.

 Add a Digital Signature: This option is used to add a visible or invisible digital signature. 

It authenticates digital information such as documents, e-mail messages, and macros by using computer cryptography.
These signatures are created by specifying a signature or by using an image of a signature for establishing authenticity, 

integrity, and non-repudiation. 
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Answer option D is incorrect. You can create a new document with the same details but it will increase the overhead
and is a very time consuming process. Answer option D is incorrect. You can create a new document with the same
details but it will increase the overhead and is a very time consuming process. 

 

QUESTION 3

You work as an Office Assistant for Blue Well Inc. The company has a Windows-based network. You want to filter data
in a PivotTable report without opening drop-down lists to find the items that you want to filter. For this purpose, you are
using a slicer. After filtering the data, you want to delete the slicer. Which of the following steps can you take to
accomplish the task? 

Each correct answer represents a complete solution. Choose all that apply. 

A. Click the slicer that you want to delete on the Options tab in the Slicer type group. 

B. Click the Macro setting, and then delete the slicer from the Macro-enabled slicers list. 

C. Click the slicer, and then press Delete. 

D. Right-click the slicer, and then click Remove . 

Correct Answer: CD 

Take one of the following steps to delete a slicer: 
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1.

 Right-click the slicer, and then click Remove . 

2.

 Click the slicer, and then press Delete. 

Answer options B and A are incorrect. These are invalid answer options. 

 

QUESTION 4

Which of the following is used to display a trend based on adjacent data in a clear and compact 

graphical representation by taking up a small amount of space? 

A. Trendline 

B. Line chart 

C. Sparkline 

D. Backstage view 

Correct Answer: C 

A sparkline is defined as a tiny chart in the background of a cell. Unlike charts on an Excel Worksheet, sparklines are
not objects. It is used because data presented in a row or column is useful, but patterns can be hard to spot at a glance.
It is used to display a trend based on adjacent data in a clear and compact graphical representation by taking up a small
amount of space. The benefit of using the sparklines is that these can be printed when a user prints a worksheet that
contains them. This feature is not available in charts. Answer option D is incorrect. The Microsoft Office Backstage view
is used to replace the traditional file menu with a new approach that uses In and Out features for efficiency. The
improved Ribbon enables users to access their preferred commands rapidly and create custom tabs to personalize the
way they work. Answer option A is incorrect. A trendline is defined in Excel 2013. It is a data visualization tool to display
the trend of a particular data range. It is used to show the slope of data points in a chart. There are various types of
trendlines, such as linear trendlines, exponential trendlines, and linear forecast trendlines. Answer option B is incorrect.
Excel provides a column chart facility to display data that is arranged in columns or rows on a worksheet. Line charts
are used to display continuous data over time, set against a common scale. In a line chart, category data is distributed
along the horizontal axis, and all value data is distributed along the vertical axis. Line charts are ideal for showing trends
in data at equal intervals. 
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A line chart should be used where category labels are text, and are representing evenly spaced Values such as months,
quarters, or years. 

 

QUESTION 5

You work as an Office Assistant for Tech Perfect Inc. You are working in a spreadsheet. You observe that while trying to
look up or match a lookup_value within an array, Excel is not able to recognize the matching value. Which of the
following are the reasons that are causing the above problem? 

Each correct answer represents a complete solution. Choose all that apply. 

A. The lookup_value or the array you are searching resides in a cell containing unseen spaces at the start or end of that
cell. 

B. The contents of the cells that are being compared may have different data types. 

C. Excel is trying to reference an invalid cell. 

D. You are inserting a new column, next to a column that is already formatted as text. 

Correct Answer: AB 

The Failure to Look Up Values in Excel error occurs when a user gets an unexpected error while trying to look up or
match a lookup_value within an array and Excel is not able to recognize the matching value. If the lookup_value or the
array the user is searching resides in a cell, the user can have unseen spaces at the start or end of that cell. This will
create the situation where the contents of the two cells that the user is comparing look the same but extra spaces in one
of the cells cause the cells to have slightly different content. The other reason is that the contents of the cells that are
being compared may have different data types. Answer option C is incorrect. The Lookup Function Won\\'t Copy Down
to Other Rows error occurs when a user uses a function in one cell and it works perfectly but when he attempts to copy
the function down to other rows, he gets the #REF error. The #REF! error arises when Excel tries to reference an invalid
cell. This error occurs if the user has referenced an entire worksheet by clicking on the grey square at the top left of the
worksheet. For Excel, this reference range is 1 to 1048576. Since the references are Relative References, Excel
automatically increases the row references when this cell is copied down to other rows in the spreadsheet. Answer
option D is incorrect. The Excel Won\\'t Calculate My Function error occurs when a user types in a function and presses
Enter, the cell shows the function as the user typed it, instead of returning the function\\'s value. The reason that causes
this problem is that the cells containing the formula are formatted as \\'text\\' instead of the \\'General\\' type. This
happens when the user inserts a new column, next to a column that is already formatted as text due to which the new
column inherits the formatting of the adjacent column. 

 

QUESTION 6
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You work as an Office Assistant for Tech Perfect Inc. You are working in a spreadsheet as shown below: 

You want to use Excel Transpose Function for copying the contents of cells B1:B3 into cells A5:C5. 

You simply type \\'=TRANSPOSE( B1:B3 )\\' into the cells A5:C5. It displays the Excel #VALUE! error message because
the cells are working independently and the function will not work for each individual cell. Therefore, it is required to
make the cells A5:C5 work together as an ARRAY. For this purpose, you are required to use an array formula. Which of
the following steps will you take to input Excel array formulas in the spreadsheet? 

Each correct answer represents a part of the solution. Choose all that apply. 

A. Type the array formula into the first cell. 

B. Highlight the range of cells that you want to use as an input in his array formula. 

C. Press CTRL-SHIFT-Tab to remove the error message. 

D. Press CTRL-SHIFT-Enter. 

Correct Answer: ABD 

The following steps are taken to input Excel array formulas: 

1.

 Highlight the range of cells that a user wants to use as an input in his array formula. 

2.

 Type the array formula into the first cell or make this cell editable by pressing F2 or clicking 

in the formula bar if a user has already specified a value into the first cell. 
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3.

 Press CTRL-SHIFT-Enter. 

Answer option C is incorrect. This is an invalid answer option. 

 

QUESTION 7

You work as an Office Assistant for Tech Perfect Inc. You are working in the spreadsheet of the company\\'s high selling
products. You want to find out the matching values. You get an unexpected error that when you attempt to look up or 

match a lookup_value within an array, Excel is not able to recognize the matching value. Which of the following steps
will you take to resolve the problem? Each correct answer represents a part of the solution. 

Choose all that apply. 

A. Remove the unseen spaces at the start or end of the first Macro cell. 

B. Delete the column having the TRIM function. 

C. Copy the contents of the new column and paste them on the top of the original column by using paste > special >
values sequence. 

D. Create a new column subsequent to the one with the additional spaces in it. 

E. Use the TRIM function in the new column. 

Correct Answer: BCDE 

In this situation, you will take the following steps: 

1.

 Create a new column subsequent to the one with the additional spaces in it. 

2.

 Use the TRIM function in the new column to get rid of extra spaces. 

3.

 Copy the contents of the new column and paste them on the top of the original column by using paste > special >
values sequence. 

4.

 Delete the column having the TRIM function. Answer option A is incorrect. This is an invalid answer option. 

 

QUESTION 8

Rick works as an Office Assistant for Tech Perfect Inc. The company has a Windows- based network. He is creating a
form through Microsoft Excel 2013. He wants to enable worksheet forms to satisfy the flexible design requirements and
to customize their appearance, behavior, fonts, and other characteristics. Which of the following will Rick use to
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accomplish the task? 

A. Form control 

B. Accounting template 

C. Trust Center 

D. ActiveX control 

Correct Answer: D 

ActiveX controls are used on worksheet forms, with or without the use of VBA code, and on VBA UserForms. They are
used when a user needs more flexible design requirements than those provided by Form controls. They have extensive
properties that can be used to customize their appearance, behavior, fonts, and other characteristics. The user can
control different events that occur when an ActiveX control is interacted with. He can also write macros that respond to
events associated with the ActiveX controls. When a user interacts with the control, the VBA code runs to process any
events that occur for that control. The ActiveX controls cannot be added to chart sheets from the user interface or to
XLM macro sheets. It is not possible to assign a macro to run directly from the ActiveX control. Answer option A is
incorrect. A form control is an original control that is compatible with old versions of Excel, beginning with Excel version
5. 0. It is designed for use on XLM macro sheets. It can be used when a user wants to simply interact with cell data
without using VBA code and when he wants to add controls to chart sheets. By using form controls, the user can run
macros. He can attach an existing macro to a control, or write or record a new macro. These controls cannot be added
to UserForms, used to control events, or modified to run Web scripts on Web pages. Answer option B is incorrect. The
accounting template is used for numbering months of a financial year to period numbering. It is used to compare month
to month, actual v budget, quarter to quarter, year to year variances. It is the initial point for other reports that need the
use of months. Answer option C is incorrect. Trust Center is where a user can find security and privacy settings for
Microsoft Office 2013 programs. 

 

QUESTION 9

Which of the following can be defined as easy-to-use filtering components containing a set of buttons that enable users
to quickly filter data in a PivotTable report, without opening drop-down lists to find the items to filter? 

A. Accounting templates 

B. ActiveX controls 

C. Form controls 

D. Slicers 

Correct Answer: D 

Slicers are defined as easy-to-use filtering components containing a set of buttons that enable users to quickly filter data
in a PivotTable report, without opening drop-down lists to find the items to filter. 

When a user uses a regular PivotTable report filter to filter on multiple items, the filter indicates only that multiple items
are filtered and the user has to open a drop-down list to find the filtering details. However, a slicer clearly labels the filter 

that is applied and provides details so that the data displayed in the filtered PivotTable report can be easily understood. 

Answer option B is incorrect. ActiveX controls are used on worksheet forms, with or without the use of VBA code, and
on VBA UserForms. 
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They are used when a user needs more flexible design requirements than those provided by Form controls. They have
extensive properties that can be used to customize their appearance, behavior, fonts, and other characteristics. The
user 

can control different events that occur when an ActiveX control is interacted with. He can also write macros that respond
to events associated with the ActiveX controls. When a user interacts with the control, the VBA code runs to process
any 

events that occur for that control. The ActiveX controls cannot be added to chart sheets from the user interface or to
XLM macro sheets. It is not possible to assign a macro to run directly from the ActiveX control. Answer option C is
incorrect. 

A form control is an original control that is compatible with old versions of Excel, beginning with Excel version 5. 0. It is
designed for use on XLM macro sheets. It can be used when a user wants to simply interact with cell data without using 

VBA code and when he wants to add controls to chart sheets. By using form controls, the user can run macros. He can
attach an existing macro to a control, or write or record a new macro. These controls cannot be added to UserForms, 

used to control events, or modified to run Web scripts on Web pages. 

Answer option A is incorrect. The accounting template is used for numbering months of a financial year to period
numbering. It is used to compare month to month, actual v budget, quarter to quarter, year to year variances. It is the
initial point 

for other reports that need the use of months. 

 

QUESTION 10

You work as an Office Assistant for Tech Tree Inc. You have created a report in a workbook in Microsoft Excel 2013.
You have included various subtotals in a worksheet in the report to verify data accuracy. You want to remove all
subtotals from the sheet before you send it to your manager. 

Which of the following steps will you take to accomplish the task with the least administrative effort? 

A. Select all the subtotals. From the shortcut menu, click the Remove All Subtotals option. 

B. Hide the rows containing subtotals. 

C. Open the Subtotal dialog box by clicking the Subtotal option in the Outline group on the Data tab. Click the Remove
All button. 

D. Delete all the rows containing subtotals. 

Correct Answer: C 

According to the question, you have to remove all subtotals from the worksheet with the least administrative effort. You
can remove all subtotals from a worksheet at a time. For this, take the following steps: Open the Subtotal dialog box by
clicking the Subtotal option in the Outline group on the Data tab. 

Click the Remove All option. 
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Answer option A is incorrect. No such option is provided in Excel 2013. 

Answer option B is incorrect. Although this will hide the rows containing the subtotals, the contents will remain there and
can be made visible by using the Unhide row option. Moreover, the question specifically specifies to remove all
subtotals from the sheet. Answer option D is incorrect. Although this step will accomplish the task, it will involve a lot of
administrative burden of selecting each row and deleting it manually. 

 

QUESTION 11

You work as an Office Assistant for Tech Perfect Inc. The company has a Windows-based network. You are creating a
business report by using. Microsoft Excel 2013. You have arranged sales data as shown below: 
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You want to provide pictorial representation of the trend of the sales data in front of each row. 

Which of the following actions will you take to accomplish the task with the least amount of administrative burden? 

A. Use stand-alone slicers. 

B. Configure form controls. 

C. Create sparklines. 

D. Create a PivotTable report. 

Correct Answer: C 

 

In order to accomplish the task with the least amount of administrative burden, use sparklines. 

Sparklines, introduced in Microsoft Office 2013, are tiny charts that can fit in a cell. The sparklines can be used to show
trends in a small amount of space. The sparklines visually summarize trends alongside data. 

The sparklines can be added through the Insert tab. Answer option A is incorrect. Stand-alone slicers are referenced
from Online Analytical Processing (OLAP) Cube functions. These stand-alone slicers can be connected with any
PivotTable 

in future. 

They can be added by using the slicer button on the Ribbon. They need to be manually linked into grids as required. 

Answer option B is incorrect. A form control is an original control that is compatible with old versions of Excel, beginning
with Excel version 5. 0. It is designed for use on XLM macro sheets. It can be used when a user wants to simply
interact 

with cell data without using VBA code and when he wants to add controls to chart sheets. By using form controls, the
user can run macros. He can attach an existing macro to a control, or write or record a new macro. These controls
cannot 

be added to UserForms, used to control events, or modified to run Web scripts on Web pages. 

Answer option D is incorrect. A PivotTable report is used to summarize large amounts of data, to analyze numerical
data, and to answer unexpected questions about data. 

 

QUESTION 12
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Rick works as a Sales Manager for Tech Perfect Inc. He is creating a report in Excel 2013. He has entered data in five
worksheets in a workbook. He wants to enter a disclaimer message in the A1 cell of each sheet in the workbook as
shown in the image given below: 

Which of the following is the easiest way to accomplish the task? 

A. Write a disclaimer message in the A1 cell of the first sheet. Copy the disclaimer message and paste it on the
remaining sheets. 

B. Write a disclaimer message in the A1 cell of the first sheet. In the other sheets, insert a formula that points to the A1
cell of the first worksheet. 

C. Select all the five sheets. Click the first sheet. Write a disclaimer message in the A1 cell of the active sheet. 

D. Select all the five sheets. Write a disclaimer message in the A1 cell of the active sheet. 

Correct Answer: D 

In order to accomplish the task, Rick should take the following steps: Select all the five sheets. 

Write a disclaimer message in the A1 cell of the active sheet. Grouping of sheets is a feature provided in Microsoft
Office Excel 2013. Selecting more than one sheet groups those sheets. When multiple sheets are grouped, data that a
user 

enters or edits in the active sheet is reflected in all sheets in the group. To select all sheets, right-click a sheet 

tab, and then click Select All Sheets on the shortcut menu. 
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Users can select multiple sheets by holding the Ctrl key while clicking the sheets. Answer option C is incorrect. Clicking
the first sheet after selecting all sheets will ungroup the sheets and the message will only get inserted in the first sheet.
Answer options B and A are incorrect. Both these options will work, but Rick will have to work more than required.
Grouping sheets is a better option to work simultaneously on multiple sheets. Users can select multiple sheets by
holding the Ctrl key while clicking the sheets. Answer option C is incorrect. Clicking the first sheet after selecting all
sheets will ungroup the sheets and the message will only get inserted in the first sheet. Answer options B and A are
incorrect. Both these options will work, but Rick will have to work more than required. Grouping sheets is a better option
to work simultaneously on multiple sheets. 

 

QUESTION 13

You work as an Office Assistant for Blue well Inc. The company has a Windows-based network. You want to create a
VBA procedure for the open event of a workbook. You are required to set the security level temporarily for enabling all
macros. Mark the option that you will choose first to accomplish the task. 

Hot Area: 
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Correct Answer: 

 

 

QUESTION 14

You work as a Sales Manager for Rainbow Inc. Your responsibility includes preparing sales report of the Sales
department. You use Microsoft Excel 2013 to prepare sales reports. You have created a quarterly sales report of the
department. After entering required data and inserting charts, you want to give a professional look to the document. You
want to produce the document with soothing graphic effects, soft fonts, and light colors. Which of the following steps will
you take to accomplish the task with least administrative burden? 

A. Use the SmartArt option. 

B. Create a new workbook through a template. Copy all data and charts of the report to the new workbook. 

C. Choose one of the pre-built themes. 

D. Select all the text of the document. Change font style to Verdana and font color to light gray. Use vibrant colors for
charts. 

Correct Answer: C 

In order to accomplish the task, you will have to choose one of the pre-built themes. 

Document 

themes work on the overall design of the entire document. It enables users to specify colors, 

fonts, and variety of graphic effects in a document. Themes change the look and feel of the document. 
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Microsoft Excel 2013 comes with a large collection of pre-built themes. Users can create their own themes for a
document. Themes can be specified through Page Layout > Themes. 

Answer option A is incorrect. The SmartArt option does not produce soothing graphic effects, soft fonts, and light
colors. 

Answer options B and D are incorrect. These options involve manual processing. 

Therefore, any formatting done manually will increase the administrative burden. 

 

QUESTION 15

Rick works as an Office Assistant for Tech Perfect Inc. He is creating a report through Microsoft Excel 2013. Rick wants
to interact with cell data but his computer does not contain VBA code and few features of his computer are still Excel 5.
0 features. Which of the following will Rick use to accomplish the task? 

A. Accounting template 

B. Trust Center 

C. Form control 

D. Evaluate Formula 

Correct Answer: C 

A form control is an original control that is compatible with old versions of Excel, beginning with Excel version 5. 0. It is
designed for use on XLM macro sheets. It can be used when a user wants to simply interact with cell data without using
VBA code and when he wants to add controls to chart sheets. By using form controls, the user can run macros. He can
attach an existing macro to a control, or write or record a new macro. These controls cannot be added to UserForms,
used to control events, or modified to run Web scripts on Web pages. Answer option A is incorrect. The accounting
template is used for numbering months of a financial year to period numbering. It is used to compare month to month,
actual v budget, quarter to quarter, year to year variances. It is the initial point for other reports that need the use of
months. Answer option D is incorrect. Evaluate Formula is the formula examination tool provided by Microsoft Excel.
This tool is useful for examining formulas that do not produce any error but are not generating the expected
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result.Answer option B is incorrect. Trust Center is where a user can find security and privacy settings for Microsoft
Office 2013 programs. 
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